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Sažetak

Tema završnog rada je izrada animacije nogometnog udarca u programu Autodesk Maya.
Ukratko je opisana aplikacija, komponente koje se koriste te način razmišljanja i pristupa izradi 
animacije. Pri izradi ovoga rada koristila se nekomercijalna verzija Autodesk Maye za edukacijske 
svrhe.

Ključne riječi

Autodesk Maya, Animacija lika u računalnoj igri, Animacija, Nogometni udarac

5



1. Uvod

U ovom završnom radu izrađena je animacija lika koji upućuje udarac (jedanaesterac) prema 
vratima.  Lik  iz  stajaće  poze  prelazi  u  kretnju  kako bi  dotrčao  i  udario  loptu  jakim,  preciznim 
udarcem u lijevu stranu vrata (gola).

Animacija[1] je metoda kojom se manipulira slikama kako bi se prikazale kao pokretne 
slike. Danas se većina animacija izrađuje uz pomoću računalno generiranih slika (CGI). Računalna 
animacija može biti jako detaljna ako se radi kao 3D animacija, dok se 2D animacija koristi iz 
stilskih razloga, male propusnosti ili bržeg prikazivanja u stvarnom vremenu.

Animacija se, osim u kratkim filmovima, dugometražnim filmovima, animiranih gif-ova i 
drugih medija namijenjenih prikazu pokretnih slika; intenzivno koristi i  za video igre, pokretnu 
grafiku  i  specijalne  efekte.  Animacija  je  široko  rasprostranjena  i  u  sučeljima  informacijske 
tehnologije.

Povijest animacije započinje još u Paleolitiku kada se je igrom sjena prikazivala animacija. 
U Iranu je otkrivena 5 200 godina stara zdjela, koja sadrži 5 sekvencijalnih slika obojanih oko nje 
koje su prikazivale faze skoka ovce pokušavajući pasti stablo.

 Najstariji tradicionalni animirani film je Fantasmagorie autora Emile Cohla iz 1908. rađen 
sa negativnim printovima crne tinte na bijelom papiru. El Apostol iz 1917. je prvi animirani igrani 
film. Prvi animirani lik koji je imao veliku popularnost je  Felix the Cat  iz 1919 iz bezzvučnog 
animiranog kratkog crtića Feline Follies. Prva animacija sa zvukom je kratki crtić Steamboat Willie  
Walta Disneya sa Mickey Mousom u glavnoj ulozi.

Postoji puno tehnika animacije od kojih su neke:
U tradicionalnoj animaciji slike se crtaju ili slikaju ručno na prozirnim celuloidnim listovima 

koji se zatim fotografiraju i izlažu na filmu. Da bi se stvorila iluzija pokreta, svaki se crtež razlikuje 
od prijašnjeg crteža (slika 1.). 
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Slika 1: Tradicionalna animacija



Potpuna  animacija  odnosi  se  na  proces  produkcije  visokokvalitetnih  tradicionalno 
animiranih filmova koji  koriste  detaljne crteže i  vjerodostojno kretanje  sa glatkom animacijom. 
Potpuno animirani filmovi mogu se izrađivati u različitim stilovima, od realističnih animiranih djela 
studija Walt Disney kao što su Mala sirena, Ljepotica i zvjer, Kralj lavova pa sve do više crtanih 
stilova studija Warner Bros.

Rotoscoping (slika  2.)  je  tehnika  Max Fleischera  patentirana  1917.  gdje animatori  prate 
kretanje  uživo  kadar  po  kadar.  Izvorni  film  se  može  direktno  kopirati  s  konturama  glumca  u 
animirane crteže gdje animatori mogu dodati specijalne efekte i sl.  Primjer filma koji koristi tu 
metodu  je  Gospodar  prstenova.  U  današnje  vrijeme  zbog  green-screen  tehnika  ovaj  proces  je 
olakšan.

Motion capture (slika 3.) (kraće mo-cap ili mocap) je proces bilježenja kretanja objekata ili 
ljudi u računalnoj animaciji. Glumci koriste posebno dizajnirana odijela kako bi se snimila scena. 
Često je bitno snimiti samo kretanje glumca pa se naknadno dodaju izrazi lica, a ako se snima i lice, 
prsti ili izrazi lica tada se često naziva i snimkom izvedbe. U današnjici se za puno igara i filmova 
koji koriste CGI (Computer-generated imagery) koristi  motion capture jer glumci mogu snimati 
scene, a onda se računalnom obradom radi animacija.
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Slika 2: Rotoscoping



Machinima su filmovi rađeni spajajući slike sa zaslona ekrana snimljenih u video igrama i 
virtualnim svjetovima.

Foto-realistična  animacija  se  koristi  prvenstveno za  animacije  koje  pokušavaju  prikazati 
stvarni život. Koristi se napredno renderiranje koje imitira detaljnu kožu, biljke, vodu, vatru, oblake 
i sl.

Animacija bazirana na fizikama je animacija koja koristi računalne simulacije. Tako se može 
animirati kretnja kose dok puše vjetar, micanje trave dok puše vjetar i sl.
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Slika 3: Motion capture



2. Inspiracija

Velike kompanije koje se bave izradom video igara ulažu puno vremena, truda i novaca 
kako bi trailerima prikazali „bit” igre, ljepotu okoliša/likova koji se u njoj nalaze te nam otkrili dio 
priče, samim time zaintrigirajući nas da odigramo igru. Kroz animaciju se može prenijeti jako puno 
osjećaja te utjecati na zainteresiranost gledatelja i njegovu empatiju prema likovima koji se u njoj 
nalaze. Svaki izraz lica, pokret likova, ambijent u kojemu se nalaze, dašak vjetra na sceni, sve te  
stvari  daju  veliki  doprinos  animaciji  kao  cjelini.  Trailerima  se  često  prikazuju  antagonisti  i 
protagonisti igre te se otkrivaju dijelovi njihovih priča. Kako se priča razvija unutar same igre, često 
se  javljaju  i  cinematici  (odvojene  video  scene  unutar  igre)  koji  nam  dodatno  pojašnjavaju  i 
razjašnjavaju priču. Animacija nam omogućuje upravo to; da ispričamo priču.

Kako  sam  nogometni  sudac  i  član  Hrvatskog  nogometnog  saveza  Primorsko-goranske 
županije,  jedna od inspiracija  mi je  bila  i  to  što  se  simulacijama pa tako i  animacijama mogu 
prikazati neke stvari koje se recimo mogu dogoditi na nogometnim terenima (neke rjeđe i neke 
učestalije situacije).  Tako se nove generacije nogometnih sudaca i  trenera mogu učiti  pravilima 
nogometne  igre  gledajući  animacije  i  učeći  promatrajući  događaje  koji  se  mogu  dogoditi  u 
stvarnosti.  Lakše  je  učiti  ako  uz  tekstualni  dio  imamo  i  neki  primjer  (iz  stvarnog  života  ili 
napravljenu animaciju koja bi nam prikazala izgled situacije kada bi se taj događaj pojavio).
Time se recimo može pospješiti rad nogometnih sudaca/trenera jer se mogu pripremiti kada bi im se 
ta situacija dogodila na terenu.
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3. Korištene aplikacije

3.1 Autodesk Maya

Autodesk Maya [2] (često nazivan samo Maya) je softver namijenjen izradi 3D modela, 
scena za filmsku i game development industriju, vizualnih efekata te animacija (slika 4.). Program 
je  nastao  kao  kombinacija  koda  „The  Advanced  Visualizer”  tvrtke  Wavefront  Technologies  i 
„PowerAnimator”-a tvrtke Alias Research te je službeno pušten u uporabu kao Maya 1.0. u veljači 
1998. godine. Maya je tokom godina dobila nekoliko nagrada od strane Academy of Motion Picture 
Arts  and  Sciences  da  bi  2005.  godine  bila  kupljena  od  strane  Autodeska,  mijenjajući  naziv  u 
Autodesk Maya. Do 2015. godine,  prema časopisu VentureBeat Magazine,  Maya je korištena u 
najboljih deset filmovima nominiranih za Best Visual Effects Academy Award i u svakom filmu koji 
je dobio nagradu od 1998. godine. Maya ima mnoge prednosti kao što su prilagodljivo sučelje, 
mogućnost simuliranja puno više materijala nego ijedan konkurentni program, kompatibilnosti  i 
razno-razne mogućnosti eksportiranja projekata u neke druge engine kao što su Unity ili Unreal 
engine. Iza glavnog Mayinog konkurenta – 3DS Max-a stoji ista kompanija pa je teško uspoređivati 
te proizvode, dovoljno je reći da su oba programa postavila standarde u industriji; Maya za izradu 
animacija, a 3DS Max za izradu specijalnih efekata.
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Slika 4: Logo Autodesk Maye



Nakon  pokretanja  programa  Autodesk  Maya  dolazimo  do  glavnog  sučelja.  U  gornjem 
desnom uglu nalazi se nekoliko već namještenih workspaceova prilagođenih korisniku koji se bavi 
pojedinim segmentima; npr. sučelje namješteno za modeliranje, sučelje prilagođeno za animaciju, 
uz mogućnosti namještanja sučelja prema vlastitom nahođenju. U gornjem lijevom uglu u statusnoj 
liniji  nalazi  se  nekoliko  opcija  u  padajućem  izborniku:  Modeling,  Rigging,  Animation,  FX,  
Rendering,  Customize koji  mijenjaju glavni  izbornik  na  vrhu (slika 5.).  Mijenjanjem tih  opcija 
dobiva se drugačiji glavni izbornik upravo kako bi se korisniku dalo na raspolaganje više opcija 
prilikom  rješavanja  zadataka.  Korisnik  može  mijenjati  izbornik  klikom,  a  napravljeni  su  i 
tipkovnički prečaci za brze promjene među opcijama [3].
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Slika 5: Sučelje za animiranje



3.2 Adobe Photoshop

Adobe Photoshop [4] je grafički računalni program namijenjen rasterskoj grafici kojeg je 
napravila američka tvrtka Adobe Systems. Trenutno je Photoshop najpoznatiji računalni program za 
obradu slike. Koristi se za stvaranje slika te izmjenjivanje postojećih.

Korišten je za izradu natpisa (slika 6.), te za modifikaciju tekstura nogometnog terena kako 
bi se smanjila veličina točke sa koje se izvodi kazneni udarac.
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Slika 6: Natpis sponzor



4. Izrada modela

Za  izradu  modela  koristimo  Maya  Classic  workspace  te  Modeling  opciju  padajućeg 
izbornika. U Mayi se modelira odabirom geometrijskih tijela, postavljajući ih i pomičući u prostoru 
uz  mogućnost  skaliranja  veličine  i  rotiranja.  Geometrijska  tijela  ili  poligoni  se  mogu,  zbog 
nevezanosti stranica i vrhova, dodavati i oduzimati kako bi se dobio željeni oblik. Poligoni su u 
prostoru određeni pomoću 3 koordinate, rotacijom po svakoj od tih osi te veličinom u odnosu na 
početnu veličinu (početna veličina svih poligona iznosi 1). Poligone možemo duplicirati, stavljati 
jedne na druge, a po potrebi i grupirati u veće cjeline.

Scena koja prikazuje model može biti pogled sa različitih strana: bočni prikaz, perspektiva, 
prikaz sa gornje ili donje strane ili neki drugi kombinirani pogled. 

U ovom završnom radu korišteni su najviše kvadratni poligoni koji su skalirani i rotirani za 
izradu  panela,  za  izradu  mreže  gola,  valjkasti  poligoni  su  korišteni  za  grede  vrata,  primitivni 
poligon za loptu dok je teren napravljen od poligonske ravnine.

4.1 Lopta

Autodesk Maya ima implementirani primitivni oblik lopte u 
Create → Polygon Primitives → Soccer Ball (slika 7.). Lopta je primitivnog oblika, nije okrugla te 
se treba izmijeniti kako bi dobila pravi oblik.

Kako je lopta jedan poligon, označe se svi vrhove te se  deatachaju kako bi „razbili” poligone na 
lopti  –  Edit Mesh → Detach.  Opcijom  Smooth dodaje se više podjela na lopti (divisions) zbog 
klasičnog oblika lopte koju se želi napraviti. Ako bi se radio drugačiji dizajn lopte tada se podjele 
moraju  prilagoditi  budućem dizajnu kako bi  se  dovršetkom modeliranja  lopta mogla  čim lakše 
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Slika 7: Primitivna 
nogometna lopta



teksturirati.  Za dobivanje okrugle lopte koristi  se opcija  Scultp.  Sculpt kod poligona omogućuje 
dodavanje volumena u ovisnosti o brojnosti vrhova. Time se dobiva okrugla lopta, a kako objekt 
zadržava povijest uređivanja, ako se lopta pokuša pomaknuti negdje drugdje, ona se opet deformira 
u poligon jer na tom mjestu nema skulpture (sfere) koja daje taj okrugli oblik. Zbog toga se briše 
povijest uređivanja  Edit → Delete by Type → History (Alt + Shift + D) te time objekt zadržava 
oblik  lopte  na  bilo  kojoj  poziciji.  Brisanje  povijesti  je  bitno  kod  svih  promjena  oblika  jer  se 
koristeći  deformere mijenja oblik objekta samo na toj poziciji u koordinatnome sustavu, a brišući 
povijest omogućujemo manipuliranje predmetom i premještanje na bilo koju poziciju. 

Lice  lopte,  prepoznatljive  peterokute  i  šesterokute  klasične  lopte,  dobivamo  koristeći 
naredbu  Extrude koja  stvara  kopiju  odabranog  objekta  na Z  osi  (npr.  kvadrat  u  2D  možemo 
Extrude-om pretvoriti u kocku). Lopta se utiskuje prema unutra kako bi se peterokuti i šesterokuti 
pojavili na površini lopte, baš kako treba. Kako je lopta utisnuta prema unutra, objekt se zatamni jer 
su se normale izokrenule utiskivanjem (kao da se lopta okrenula iznutra-van). Reverse naredbom se 
izokreću normale. Tipkovničkim prečacem 3 (Smooth Quality Display) prikazuje se površina lopte. 

Događa se da se šavovi na lopti ne poklapaju dobro te izgleda kao da je lopta probušena na 
mjestima između peterokuta i šesterokuta zbog crnih rupa. Taj problem se rješava smanjivanjem 
razmaka između šavova kako bi se šavovi približili.  To se radi  klikom na  polyExtrudeFace na 
Layer Editoru, u opciji Offset koja se sa 0 podešava na vrijednost -0.03 do -0.05. 

Za kraj lopta se boja tako da se označe svi peterokuti na lopti koji se žele obojati i odabere 
se odgovarajući materijal. Postupak je: držeći desni klik otvara se meni te se pri dnu odabire Assign 
New Material (slika 8.).
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Slika 8: Klasična nogometna  
lopta



4.2 Nogometna vrata

Nogometna vrata se sastoje od greda i mreže. Izrada samih greda nije problem, koristi se 
valjak prilagođavajući dimenzije izgledu i obliku grede. Ono što predstavlja veći izazov je mreža 
gola. Mreža se sastoji od kvadratića pa je zanimljiv pristup kako napraviti mrežu. Možemo raditi  
šuplje  kvadratiće  pa  ih  povezivati  zajedno  kako  bi  dobili  oblik  mreže,  no  to  je  zahtjevno  i 
nepotrebno  jer  postoje  brojni  drugi  načini  kako  napraviti  kvalitetnu  mrežu.  Odabrani  način  je 
stvaranje mreže kvadratića sa razmacima između svakog da bi izbrisali kvadratiće i ostavili samo 
razmake između njih koji nam čine – mrežu. 

Prvo se napraviti kvadrat –  Create  → Polygon Primitives → Cube ili klikom na  Polygon 
Cube koji se nalazi na alatnoj traci unutar Poly Modeling kartice. Zatim se radi mreža nogometnog 
gola, klikne se na kvadrat te u opcijama desno gdje se nalazi povijest polyCube, klikne se da bi se 
vidjela svojstva te se pronalazi Subdivisions Width. Označuje se to svojstvo te držeći srednju tipku 
miša vuče lijevo-desno namještajući mrežu na kvadratu dok se ne zadovolji širina mreže. Isto se 
ponavlja za  Subdivisions Height gdje se namješta visinu mreže te  Subdivisions Depth za dubinu 
mreže. Nakon toga se prebacuje u bočni pogled gdje se vidi bočna strana kvadrata. Držeći desni klik 
dok je objekt označen otvara se set opcija i bira  Face. To omogućava povlačenje kursora jednom 
stranom držeći shift te označavajući bočne kvadratiće da bi ih obrisali tipkom Delete. Isti postupak 
je i sa donjim kvadratićima te se u konačnici dobiva bazni oblik mreže (slika 9.). 
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Slika 9: Oblik mreže



Sljedeći korak je promijeniti opciju u padajućem izborniku (u statusnoj liniji) u Animation. 
Označivši objekt te ide se u Create Deformers → Lattice te se klikne kvadratić kako bi se otvorila 
svojstva. Mijenja se Divisions tako da opcije budu 2, 2, 2; to je broj točaka koji će se pojaviti kada 
uključimo opciju.  Ostale opcije ostaju nepromijenjene te se klikne na  Create.  Lattice deformeri 
omogućavaju deformaciju objekta na način koji se želi, obično neko zakrivljenje stranica, izduženje 
i sl. Što je broj točaka veći, time se može detaljnije i bolje deformirati objekt zbog više točaka oko 
kojih se vrše deformacije pa se može namještati razna izduženja, smanjenja i sl. pomičući veći broj 
točaka čime se dobiva veću točnost. Držeći desni klik klikne se na rešetke koje su se pojavile (u 
našem slučaju  zbog  divizija  to  je  prazni  pravokutnik  )  i  odabire  Lattice  Point.  Sada  se  mogu 
odabrati  dvije gornje točke (odabere se jedna pa držeći shift  i druga točka) te se sa Move tool-om 
(W na tipkovnici) miču dok se ne dobije željeni oblik (slika 10.).

Ponovno se radi Delete by Type → History jer inače deformacija ne ostaje očuvana kada bi 
se objekt pomaknuo. Potrebno je još napraviti mrežu, objekt se označi i ide na
Edit Mesh → Bevel ili kraće Ctrl + B na tipkovnici. Otvaraju se postavke te se namješta Fractions 
na 0.05. To su razmaci između pravokutnika, fuge koje ih razdjeljuju.
Pravokutnici se moraju obrisati tako da ostane samo ono između kako bi se dobio oblik mreže. 
Držeći desni klik odabire se  Face kako bi mogao odabrati samo pojedini pravokutnik, odabire se 
jedan pravokutnih i odabire opcija  Select → Similar kako bi se odabrali i ostali kvadratići te se 
brišu. Postupak se ponavlja ako ostane koji kvadratić nakon brisanja ili se preostali ručno obrišu.
Napravljena je mreža gola (slika 11.).
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Slika 10: Lattice deformer



Za pravljenje  vratnica  i  greda  ide  se  na  Create  → Polygon  Primitives  → Cylinder (ili 
pripadna ikona koja se nalazi na workspace-u). Odmah se mogu specificirati željene dimenzije pa 
da  valjak  bude  duguljast  i  dovoljno  uzak  za  vratnicu  ili  se  to  može  postići  skaliranjem  ako 
dimenzije nisu zadovoljavajuće. Kako je oblik gola i mreža već pripremljena, ostaje posložiti grede 
na pripadna mjesta kako bi se gol dovršio. To se može napraviti na više načina: može se posložiti  
grede na pola strane gola pa koristiti  naredbu  Mesh → Mirror kako bi zrcalili  grede na drugu 
polovicu gola ili ovdje odabrani pristup, a to je slaganje gredu po gredu na mjesto. Naravno, kod 
kompleksnijih modela najbolje je koristiti Mirror kada god je to moguće kako bi se olakšao posao i 
znatno uštedilo na vremenu. Kompletirana je izrada modela gola (slika 12.).
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Slika 11: Primjer mreže

Slika 12: Model gola



4.3 Model lika

Kako je Autodesk Maya već dugi niz godina na tržištu, postoje gotovi bazni modeli likova 
za  korisnike.  Preuzet  je  bazni  model  čovjeka  (slika  13.),  ostali  teksturirani  modeli,  modeli  s 
odjećom i sl. se naplaćuju.

 

Za  animiranje  modela  čovjeka,  mora  se  napraviti  kostur  i  spojiti  kostur  sa  tijelom. 
Mijenjajući opciju padajućeg izbornika na Rigging, označi se tijelo lika i ide na  Control → Create  
Control Rig. Pojavljuje se izbornik sa desne strane gdje se bira Quick Rig Tool (slika 14.).
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Slika 13: Model čovjeka

Slika 14: Quick Rig Tool



Zatim se otvara izbornik Quick Rig u kojem se namještaju postavke za pravilno generiranje 
kostura. Klikne se na Step-By-Step opciju te klikom na „+” znak sa strane započinje namještanje. 
Još jednom kliknuvši na „+” dodaje se geometrija lika, bira se Imperfect Mesh kao Embed Method i 
klikne  na  Create/Update gumb.  Program  tada  generira  Guidove  –  točke  na  liku  koje  će  biti 
zglobovi. 

Nisu svi zglobovi namješteni kako treba, zglob koji bi trebao biti na laktu nalazi se previše u 
desno pa se mora običnom naredbom za micanje pomaknuti točku na mjesto gdje je lakat, isto i za  
koljeno,  a  kako  se  ne  bi  moralo  namještati  na  drugoj  nozi  /  ruci,  postoji  opcija  Mirror koja 
preslikava poziciju točke na suprotnu stranu kako bi točke bile jednako pozicionirane s lijeve i 
desne strane. Kada je to namješteno može se izgenerirati kostur te se kao posljednji korak klikne 
Create/Update kako bi se tijelo povezalo sa kosturom (slika 15.).
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Slika 15: Model s kosturom



Uređujemo lika radi lakše vizualizacije tako što neke dijelove kostura mijenjamo u linije i 
krugove, dok zglobove ostavljamo kao kocke i kvadrate jer oni su nam ključ pomicanja lika (slika 
16.).

4.4 Pozadina

Teren je  napravljen kao poligonska ravnina.  Travnati  nogometni  tereni  imaju  jako malu 
travicu  stoga  je  generiranje  prave  trave  nepotrebno.  Za  podlogu  je  dovoljna  tekstura  trave 
nogometnog terena koju postavljamo na ravninu (slika 17.).
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Slika 16: Uređeni kostur modela

Slika 17: Tekstura nogometnog terena



5. Izrada animacije

5.1 Priprema i istraživanje

Za animiranje nogometnog udarca potrebno je poznavati pravila koja su nužna za pravilno 
rekreiranje udarca. Bitno je kako igrač natrčava na loptu, kojom nogom udara loptu te jačina udarca. 
Nakon provedenog istraživanja metoda udaraca,  uočeno je da se za izvođenje kaznenog udarca 
najčešće koristi  jaki,  precizni  udarac sa vrlo malo rotacije  lopte.  Prikazane su pravilne metode 
izvođenja takvog udarca te se sam čin može prikazati u nekoliko koraka.

Prvo, dotrčavanje do lopte, ovisi o pojedincu koji izvodi udarac. U pravilu, što je veći zalet, 
time je udarac jači jer se na loptu natrčava većom brzinom i sa jačom udarnom snagom. Za jaki 
udarac s bijele točke dovoljan je zalet od svega nekoliko koraka. 

Druga stvar koja je bitna za pravilno izvođenje jakog udarca je stav igrača prilikom naleta i 
udaranja lopte (slika 18.). Ako je tijelo previše nagnuto unatrag, lopta putuje više u zrak, zbog toga 
tijelo mora biti ravno, malo skvrčeno te se zamahom noge iz koljena upućuje jaki udarac. 
 

Obavio sam testiranja,  odmjeren je  zalet  od 4 koraka prema lopti  te  sam odlučio da će 
udarac na gol biti jakim udarcem. 

Kamerom  mobitela  napravljeno  je  oko  6  snimaka  udarca  sa  bočne  strane,  prosječnog 
trajanja videa od 14 sekundi sa frame rate-om od 30 f/s. Snimke su tada analizirane i uočilo se da se  
način dotrčavanja do lopte kao i udarac lopte znatno ne mijenjaju. Pokazalo se da je poza udarca 
ista jer se samo na taj način može proizvesti jak udarac, dok se dotrčavanje do lopte razlikuje od 
osobe do osobe. Odabrala se jedna snimka te se krenulo u „razbijanje” videa u slike, s ciljem da se 
vidi prijelaz između poza kako bi se čim lakše i bolje napravila animacija. Napravljene su slike svih 
prijelaza među koracima gdje je uočeno da je uvijek jedna noga na podu, ključna poza prije udarca 
lopte gdje su obje noge na trenutak u zraku te ključna poza prilikom udarca lopte. Za kraj još ostaje  
mali skok nakon udarca lopte.
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Slika 18: Poza 
prilikom udaranja 

lopte



U nastavku su dane usporedbe poza sa testiranja sa pozama lika u animaciji.
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Slika 19: a) Početni korak 
b) Korak prije udarca  

.             c) Udarac lopte



Postoji nekoliko načina kako napraviti dobru animaciju. 
Prvi način je odabrati glavne poze animacije. To su obično one poze koje sadržavaju ključne 

informacije prilikom određenih radnji. 
Kod hodanja četiri glavne poze su (slika 20.): 

1. poza – kontakt poza, oba stopala su na podu i težina tijela je rasprostranjena u svakoj nozi,
2. poza – prelazna poza, jedno stopalo je na podu dok je drugo podignuto. Oba stopala prelaze 

na sljedeću kontakt pozu, 
3. poza –  gore poza, koja definira ekstreme glave kada je glava u višem položaju prilikom 

koračanja,
4. poza –dolje poza,  koja definira ekstreme glave kada je glava u nižem položaju prilikom 

koračanja.

Poze hodanja  se  na sličan  način  mogu primijeniti  u  animiranju trčanja.  Jedan normalan 
ciklus hodanja (dva koraka) se odvija u 24 framea (1 sekunda), dok se kod trčanja jedan ciklus 
odvija od 8-14 frameova, u ovisnosti o željenoj brzini trčanja kao i stilu animacije. Obično se 
kod animiranja rade glavne poze te  se  između tih  poza dodaje još  keyframeova kako bi se 
„izgladila” animacija.
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Slika 20: Četiri glavne poze [5]



5.2 Animiranje u Mayi

Workspace  i  izbornik  postavimo na  animation,  čime  nam se  pojavljuje  sučelje  sa  svim 
potrebnim  opcijama  za  animiranje.  Ako  su  se  modeli  radili  u  zasebnim  Maya  projektima, 
jednostavnim importanjem projekata možemo sve „spojiti” u novi Mayin projekt, gdje ćemo sve 
komponente imati na jednom mjestu kako bi mogli napraviti animaciju. 

Ključni pojmovi animacije su svakako  frameovi i  keyframeovi (slika 21.).  Frame  je jedna 
sličica od puno nepokretnih slika koje čine cjelovitu pokretnu sliku. Keyframe je slika koja definira 
početne i krajnje točke prijelaza. Niz keyframeova definira koji pokret će gledatelj vidjeti, a pozicije 
keyframeova  u videu ili animaciji definiraju vrijeme pokreta. Zbog toga što dva ili tri  keyframea 
preko sekunde ne stvaraju iluziju pokreta, preostali frameovi se ispunjavaju sa inbetweens [6].
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Slika 21: Frameovi sa 1 keyframeom



5.2.1 Animiranje lika

Nakon što je model postavljen na scenu, započinjemo proces animacije. Klikne se na prvi 
frame i namjesti model u željenu pozu. Zatim, dok je željeni kadar označen (u ovom slučaju prvi),  
preko izbornika  Key  → Set  key ili  kraticom „S” na tipkovnici radimo  keyframe na označenom 
kadru. Time je poza modela spremljena na tom kadru te se može kliknuti na neki drugi frame kako 
bi se ponovno mijenjala poza modela i nastavilo sa animacijom. 

Pristup koji je odabran za animiranje je korak po korak pristup. Svaki frame je posebno 
animiran, pazeći na svaku pozu, kako bi u konačnici animacija izgledala što realnije. 

Zbog dobre pripreme - od videa napravljene slike koje prate dotrčavanje do lopte i udarac, 
prateći slike namještaju se poze lika. 

Bitno  je  prikazati  kako se lik  lagano naginje  naprijed  kada  kreće  u  iskorak  (slika  23.), 
nastavlja zadržavati pogrbljenost dok hvata zalet te njegovi pokreti ruku prilikom trčanja. Obraća se 
pažnja na to koliko se lik miče unaprijed kada trči nakon svakog koraka te u konačnici koliko je 
odskočio nakon udarca. Potrebno je paziti na razmjere jer se može dovesti u situaciju da neka radnja 
postane neprirodna i čudna. Tako se ističe poza prije udaranja lopte kada su obje noge u zraku malo 
iznad tla (slika 22.).

 

Ono što je najbitnije je pravilna poza prilikom udaranja lopte (slika 18.). Tijelo je ravno, malo 
prigrbljeno, a desnom nogom radi se snažni zamah i  udara lopta.  Ovdje je prilikom animiranja 
ostavljeno  svega  3  frame-a  razmaka  od početka  zamaha  desnom nogom pa do udaranja  lopte. 
Razlog tome je realističnost udaranja lopte jer  za jaki udarac imamo izuzetno brz pokret noge. 
Ostavljanje više frameova dosta bi usporilo kretnju te bi tada izgledalo više kao neko nabacivanje ili 
dodavanje lopte. 
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Slika 23: Prvi korak Slika 22: Poza prije udaranja 
lopte



Vrlo bitan alat animacije je  Graph Editor –  grafički prikaz interpolacija između frameova 
koji korisnik može modificirati.  Tako se neki dijelovi animacije mogu dodatno „izgladiti” preko 
Graph Editora. Graph Editor  sadrži sve promjene prijelaza i rotacija na svakoj osi. Sa strane u 
izborniku možemo gledati prijelaze i rotacije svake pojedine osi zasebno ili kombinaciju više osi, uz 
mogućnost gledanja samo prijelaza, gledanja samo tranzicija ili oboje.

 Prikazati ćemo na primjeru pomicanja lijeve ruke lika (slika 24.).  Promatra se pomicanje 
lijeve ruke,  a pod time smatramo položaj  lijevog zgloba u odnosu na osi.  Radi  jednostavnosti, 
promatrat  ćemo  samo  promjene  položaja  Y osi.  U  prvom koraku  (lijeva  sličica)  dok  je  lik  u 
mirovanju, ruka, odnosno zglob lijeve ruke, je u najnižoj točki i ta točka nam postaje referentna 
točka grafa. Kako lik zamahuje rukom tako se i graf postepeno mijenja kako lijevi zglob mijenja 
koordinate u odnosu na početnu vrijednost. Graf dostiže svoj maksimum u 25 kadru kada je ruka na 
najvišoj točki s obzirom na Y os što je i prikazano na grafu (slika 25.).
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Slika 24: Pomicanje lijeve ruke lika

Slika 25: Graph Editor promjena lijeve ruke u odnosu na os Y



Prikazati  ćemo još i  pomicanje lijevog i  desnog stopala u  Graph Editoru  promatranih u 
odnosu na Z os (slika 26. plava boja). Radnje koje obuhvaćaju X os označene crvenom bojom, Y os 
sa zelenom bojom i Z os sa plavom bojom.

Vidimo da je lijevo stopalo (slika 26, prva sličica) malo zakošeno prema dolje i to je najveće 
zakošenje koje lijevo stopalo postiže u drugom, najdužem koraku (slika 27.).
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Slika 26: Pomicanje lijevog i desnog stopala

Slika 27: Graph Editor lijevog stopala



Desno stopalo (slika 26.,druga sličica) postiže najveće zakošenje u odnosu na Z os prije 
udarca lopte, odnosno u trenutku kada desna noga postiže najvišu točku luka za udarac (slika 28, 
plava krivulja.).
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Slika 28: Graph Editor desnog stopala



Kompletna animacija lika prikazana u Graph Editoru na slici 29. Ovdje su objedinjene sve 
osi (X - crvena boja, Y - zelena boja, Z - plava boja) i sve njihove tranzicije i rotacije. Sa strane se 
može  odabrati  pojedina  os  ili  kombinacija  više  osi  za  pregled,  kao  i  pregled  samo  prijelaza 
(tranzicija) ili samo rotacija ili oboje.

Animacija lopte, započinje nakon što lik udari loptu.  Graph Editorom  se namješta brzina 
lopte na pojedinim dijelovima (slika 30.). 
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Slika 29: Animacija lika u Graph Editoru

Slika 30: Animacija lopte u Graph Editoru



5.2.2 Animiranje lopte

Kada se završi s animacijom lika, animira se lopta. U trenutku kada igrač udari loptu (slika 
14.)  počinje  animiranje  lopte.  Lopta  se  može  animirati  po  frameovima,  a  ovdje  je  odabrano 
animiranje pomoću staze kretanja (motion path, slika 31.). 

Koristi se  EP Curve  jer daje najbolje zaobljene uglove za ono što nama treba te je lakše 
naglo skrenuti, a da nam pritom ostane lijepi luk. Krivulja se namješta u prostoru tako da prati 
stvarno kretanje lopte nakon udarca. Lopta je udarena jako te nema veliki luk, otprilike negdje na 
polovici dostiže najveću točku te se lagano spušta. Nakon udaranja u mrežu odbija se u stranu te se 
kotrlja prema van. Loptu namjestimo na početak krivulje te se koristi Motion Paths. 

Animacija lopte započinje nakon što je lik udari, a to je u 28. kadru te tada lopta započinje 
svoju putanju koja završava u 100. kadru.  Označi  se lopta,  odabere 28.  frame te  koristeći  „S” 
tipkovnički prečac radi se ključni kadar (keyframe) te Shift + E komandu koja nam sprema rotaciju 
modela. Krećući se po keyframeovima pratimo kako se lopta kreće po motion pathu. Uočava se da u 
35. kadru lopta udara u mrežu odbijajući se u stranu. U opcijama desno gdje nam je povijest klikne 
se na motionPath  te u opcijama U Value, desnim klikom na njega te odabirući Key Selected se na 
krivulji pojavljuje brojka koja označava kadar. Dodaje se još par keyeva na krivulji kako bi se mogli 
namjestiti brzinu lopte između kadrova.

Otvara se Graph Editor kartica za namještanje grafa kako bi se postigla željena brzina lopte 
na određenim segmentima krivulje. Od 42. pa do 93 kadra lopta usporava nakon što se odbila od 
mreže u teren. Usporavanje lopte postižemo namještajući krivulju u Graph Editoru između dviju 
točakaf. Što je strmiji graf između dvije točke, to  lopta brže putuje, manja razlika u visini između 
dvije točke, odnosno dva kadra, znači usporavanje lopte. Pri kraju između 93. i 100. kadra lopta još 
više usporava kako bi se u potpunosti umirila u 100. kadru (slika 32.).
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Slika 31: Motion path



6. Zaključak

Razvojem tehnologije omogućeni su razni alati za razvoj modela i animacija. U prošlosti su 
animatori radili sliku za slikom (frame by frame) i trebalo im je puno slika kako bi prikazali neku 
priču. U današnjici je puno lakše raditi animacije pa se stoga i duljina animiranih filmova / crtića 
znatno produžila. Omogućeno je lakše stvaranje likova i objekata kao i nekih efekata pa je doista u 
ovim vremenima, ne gledajući materijalni dio i  potrebu za softverom i hardverom, samo mašta 
granica za stvaranje animacija.

Završni rad se sastojao od istraživanja metoda udarca i načina animiranja, pripreme svih 
modela koji će biti uključeni u animaciju te u konačnici animiranje koje je također bilo zahtjevno. 
Najbitnije je bilo dobro napraviti poze lika kako bi animacija bila što glađa, a nakon toga namjestiti 
brzinu izvođenja same animacije i udaranja lopte kako sve to ne bi izgledalo presporo, a ni prebrzo.
Želja mi je bila napraviti motion capture animaciju koju, nažalost,  zbog tehničkih i materijalnih 
ograničenja nisam mogao napraviti. No, ovakav način animiranja dao mi je uvid u kompleksnost 
ovog područja, ali je također pobudio želju da stvaram i animiram. 
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Slika 32: Brzina lopte po krivulji
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8. Prilozi

Projekt izrađen kao završni rad nalazi se na priloženom CD-u.
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	Sljedeći korak je promijeniti opciju u padajućem izborniku (u statusnoj liniji) u Animation. Označivši objekt te ide se u Create Deformers → Lattice te se klikne kvadratić kako bi se otvorila svojstva. Mijenja se Divisions tako da opcije budu 2, 2, 2; to je broj točaka koji će se pojaviti kada uključimo opciju. Ostale opcije ostaju nepromijenjene te se klikne na Create. Lattice deformeri omogućavaju deformaciju objekta na način koji se želi, obično neko zakrivljenje stranica, izduženje i sl. Što je broj točaka veći, time se može detaljnije i bolje deformirati objekt zbog više točaka oko kojih se vrše deformacije pa se može namještati razna izduženja, smanjenja i sl. pomičući veći broj točaka čime se dobiva veću točnost. Držeći desni klik klikne se na rešetke koje su se pojavile (u našem slučaju zbog divizija to je prazni pravokutnik ) i odabire Lattice Point. Sada se mogu odabrati dvije gornje točke (odabere se jedna pa držeći shift i druga točka) te se sa Move tool-om (W na tipkovnici) miču dok se ne dobije željeni oblik (slika 10.).
	Ponovno se radi Delete by Type → History jer inače deformacija ne ostaje očuvana kada bi se objekt pomaknuo. Potrebno je još napraviti mrežu, objekt se označi i ide na
	Edit Mesh → Bevel ili kraće Ctrl + B na tipkovnici. Otvaraju se postavke te se namješta Fractions na 0.05. To su razmaci između pravokutnika, fuge koje ih razdjeljuju.
	Pravokutnici se moraju obrisati tako da ostane samo ono između kako bi se dobio oblik mreže. Držeći desni klik odabire se Face kako bi mogao odabrati samo pojedini pravokutnik, odabire se jedan pravokutnih i odabire opcija Select → Similar kako bi se odabrali i ostali kvadratići te se brišu. Postupak se ponavlja ako ostane koji kvadratić nakon brisanja ili se preostali ručno obrišu.
	Napravljena je mreža gola (slika 11.).
	Za pravljenje vratnica i greda ide se na Create → Polygon Primitives → Cylinder (ili pripadna ikona koja se nalazi na workspace-u). Odmah se mogu specificirati željene dimenzije pa da valjak bude duguljast i dovoljno uzak za vratnicu ili se to može postići skaliranjem ako dimenzije nisu zadovoljavajuće. Kako je oblik gola i mreža već pripremljena, ostaje posložiti grede na pripadna mjesta kako bi se gol dovršio. To se može napraviti na više načina: može se posložiti grede na pola strane gola pa koristiti naredbu Mesh → Mirror kako bi zrcalili grede na drugu polovicu gola ili ovdje odabrani pristup, a to je slaganje gredu po gredu na mjesto. Naravno, kod kompleksnijih modela najbolje je koristiti Mirror kada god je to moguće kako bi se olakšao posao i znatno uštedilo na vremenu. Kompletirana je izrada modela gola (slika 12.).
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